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KeyWallPRO QuickStart Guide
- Simple Wall Design -

This QuickStart guide is an introduction to preparing a simple wall design. KeyWallPRO is a powerfull
design program with numerous features so the User should utilize the Help files and experimentation to
learn about all the features and options prior to preparing estimates and designs.

New Full Wall Design is selected from the New Project listing under the File menu.

KeyWall PR@

KeyWall PRE@

Vesion 1390530 Keystone Reaining Vil ysems LLC

This guide assumes the User has reviewed the File Management and Saving Guide to set up a project
backup path and can fill in the appropriate client, project name, backup path, etc. information during this
process.

The following steps are the simplest and fastest way to generate a wall design without addressing the
many setting and variations that KeyWallPRO allows. Preliminary design estimates and final wall designs
in the real world require complying with specifications, design methodologies, and more complex design
situations than a simple example can address.

Step 1 - Review Program Options and Settings.

Step 2 - Select Design Methodology and Create Wall.

Step 3 - Review Empirical Design Criteria.

Step 4 - Select Keystone Wall Unit and Batter.

Step 5 - Select Soil Reinforcement and Parameters.

Step 6 - Enter Exteme Event criteria.

Step 7 - Enter Top and Bottom Wall Geometry.

Step 8 - Review and Modify Wall Panel Layout if needed.

Step 9 - Add Slope or Surcharge Loading Conditions as needed to any or all sections.

Step 10 - Generate and Review Trial Wall Design.

Step 11 - Generate Printout of Quantities and Calculations.
The Simple Wall Design in intended to show the basic steps necessary to perform a simple wall design.

Every program tab permits modification to many parts of the design and geometrical layout so walls in
practice may be considerably more complicated than this simple example.
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Step 1 - Review Program Options and Settings

Reviewing the KeyWallPRO Options is a good place to start when first using the software prior to

designing a wall. These global settings apply to all wall designs generated by KeyWallPRO and should
be set at the beginning of program use although they can be changed at any time.

1.

Select Options from the Settings drop-down menu list.
2.

Review the various options under the tabs prior to program use.

Step 2 - Select Design Methodology & Create Wall

A design methodology is the User's choice but can be mandated by project requirements. Each design
methodology has its own requirements and methods so the answers will be different for each method for

the same retaining wall. The User should become familiar with each methodology before selection to
understand the benefits and limitations of each.

3.  Select a design methodology from the Methodology drop-down menu list (NCMA selected in
this example)

4. Press the Create Wall button.

Enter name or number of wall in the dialog box and press the OK button. Wall names or
numbers will be listed along the top of progrfa{n window for easy access.

Options \</ ==
Analysis |Reinforcement | Stabilty | Project Fie Location | Report | Other
Indude Vertical Forces (NCMA only)
¥] Include Embedment in Bearing Capacity (NCMA)
{K] Project 2018: Sample Wall Design [Rev. 1] - KeyWallPR( Indude Embedment in Bearing Capacity (AASHTO) == EcR =]
- = Use Vertical Earth Pressure Factor, EV, for internal tension per AASHTO
ity el | (othernise use LL in addition to EV)
B ©  Standard Mode Indlude Passive Pressure (CMAA / AS 4678 only) KeyWa l l P Re.
Professional Mode
al v
s [0S - 7] Enable Live and Dead Load Reduction due to Offset (NCMA)
Project Name
Sample Wall Design
Project Location
USA  OK X cancel
Project Number  Prepared By
|
018 p dpcopy | [ gPsetasactve | [ = pelete |
Revision Notes
Template: None

Methodology New Wall =
| National Concrete Masoniy Assoiation 3rd Edition ~|

AASHTO 2010 1RFD) Exieia o e ol
3 )| pastio 2015 tero) ‘ Sample Wall #1

AS 4678 (Australia)

National Concrete Masonry Association 3rd Edition

Rankine Theory Analysis
S Mmperia

@ Create Wall
Project Notes

o)

Project Files

Folder Path
W:AKWP TEST FILES

Version: 1.38.50.919

[National Concrete Masonry Association 3rd Edition

Keystone Retaining Wall Systems LLC
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Step 3 - Review Empirical Design Criteria

Design Criteria can be modified for each wall and reflects both empirical design criteria as well as
factors of safety and load/resistance factors depending on design methodology.

The empirical criteria is the most useful to review since they control aspects of the wall and
reinforcement layout that would be of most interest to the wall designer. The example below looks at the

empirical criteria for the Reinforced Analysis and Common Criteria for the selected wall under NCMA
criteria for this example.

Select the Design Criteria tab then the Reinforced Analysis type and Empirical Checks.
Review and edit the reinforcement spacing criteria as needed.

» Max. Reinforcement Separation limits reinforcement spacing between levels (ft.).

* Max. multiple of Hu limits reinforcement spacing from the top and bottom of wall in block
height increments (no. of blocks).

Review and edit the reinforcement length criteria as needed.

* Min. anchorage length is the minimum distance beyond failure plane (ft.).

* Min L/H ratio is the minimum base to height ratio regardless of calculation (ratio)
* Min. reinforcment length is the minimum length regardless of calculation (ft.)

Select the Common Criteria type and Empirical Checks (criteria applies to reinforced or
gravity walls).

Review and edit the minimum embedment criteria criteria as needed.

Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO
File Walls Settings Help

o o]

Project || Sample Wall #1

Design Criteria | wall Unit | Reinforcement | Soi Conditions | Extreme Events | Stations | Panels | Loading Conditions | Design | Internal Compound Stabilty

National Concrete Masonry Association 3rd Edition

Analysis Types
i) Renforced Anaiyss
R frats
Common Criteria
No Fines Analysis

7N\
[ Design Notes | Empirical Checks |{ 1 Jsafety [ Design Inputs
v

Term | Name

|uoM |MinDef. |MaxDef. |MinUsed |MaxuUsed |
Rs Max. Reinforcement Separation ft nfa 26667 nfa 2.0000
RsBottom Max. multiple of Hu at bottom nfa 3.0000  nja I @
RsTop Max. multiple of Hu at top nfa 25000  nfa 2.5000
La Min. Anchorage Length ft 1.0000 nfa 1.0000 nfa
LHHRatio Min. LM Ratio 06000  nfa 06000 nfa @
L Min. Reinforcement Length ft 4.0000 nfa 4.0000 nja

National Concrete Masonry Association 3rd Edition

Analysis Types
Reinforced Analysis

@ o Fines Analysis

Design Notes | Empirical Checks | Factors of Safety | Design Inputs|

Term |Name |uoM |MinDef. |MaxDef. |MinUsed |MaxUsed |

MinHemb Minimum Embedment

inch  6.0000 nfa 6.0000 nfa
Hemb Minimum Embedment % % 10.0000 nfa 10.0000 nfa
Hemb2 Minimum Embedment over 18.4° toe % 142800 nfa 14.2800

nfa

| (2 Restore Default Values |

Version: 1.38.50.919

[National Concrete Masonry Association 3rd Edition

Keystone Retaining Wall Systems LLC
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Step 4 - Select Unit Type

The Wall Unit tab is for selecting the appropriate Keystone unit for the wall design. The User should
have knowledge of locally available Keystone products and the appropriateness of selected products for
a given project's structural and aesthetic requirements.

Under the Unit Type tab, Keystone units can be selected first from the Product Line dropdown menu
box that defines the product type and then from the Units dropdown menu box which provides a list of
possible products for that product line included in the software data file.

The Wall Unit tab allows the User to define wall batter for variable batter system and also specify the
capping size on top of the wall. Design information is provided after the unit is selected. There is also an
option to define leveling pad dimension and top of wall alignment that will not be addressed.

a2

Select Product Line and select Keystone Pinned Systems for this example.
Select Wall Unit and select Compac Il unit.
Leave Cap Height set at Half Height default.

Leave Fascia Batter set at 8° default.

Leave other items at defaults shown.

Project 2018: Example [Rev. 1] - KeyWallPRO
File Walls Settings Help

Project || TEST

(E=8 Ho ==

KeyWall PR@

| Design criteria | Wall Uit | Reinforcement [ Soi Conditions | Extreme Events | stations | Panels | Loading Conditions | Design | Internal Compound Stabilty

Product Line
Keystone Pinned Systems -

Key S
Reystone [ip/Cug Systems

[compac mr -]

[ Assign wall it to Al walls

Century Wall

Compac II

‘ompac 115 &.4in
Country Manor
Half Century Wall
Standard 18
Standard 21
Standard III 18
Standard 1T 21
Stonegate

Depth FronttoBack: 12,000 inch
Unit Weight: 120,000 Ib/fe2
Pins / Unit: 2
Center of Gravity: 6.000 in

Facia Batter (deg):| 8.000 |

Hollow Core %: 41.67

= o [T [ N@

Initial Shear Capacity:  1393.000 Ibjft Apparent Shear Angle: 34.00

Max. Shear Capacity: ~ 3245.000 b/ft

Max. Rein. Separation: 3.00 blocks

Leveling Pad Top of Wall

@ Above Profile Grade
Base Extent. Base Thickness

Below Profile Grade
6.000 inch 6.000 inch,

@ Distance 00000 inch

<1mn>

Version: 1.39.0.925 [National Concrete Masonry Association 3rd Edition

] Keystone Retaining Wall Systems LLC
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Step 5 - Select ReinforcementType

The Reinforcement tab is for selecting the appropriate soil reinforcement that goes with the selected
Keystone unit for the wall design. The User should have knowledge of locally available geosynthetic

products and the appropriateness of selected products for a given project's geotechnical and structural
requirements.

Under the Reinforcement tab, a geosynthetic supplier/manufacturer can be selected from the Suppliers
dropdown menu box. Then the products tested with the Wall Units selected previously will be presented

in the Available Products listing. One or more products can be selected for use in the wall by double-
clicking on the selection or using the arrow buttons.

After the Reinforcement and the Soil Category are selected, the design parameters are filled in on the
remainder of the screen.

1.  Select Supplier dropdown menu and select TenCate Mirafi - Miragrid for this example.

2. Select 3XT - Miragrid 3XT from the product listing.

3. Double-click or press arrow key to move 3XT - Miragrid 3XT to be "Used in this wall".

4.  Select the Soil Category dropdown menu and select Sands as the reinforced fill material type
to establish an appropriate installation damage value, RFid, based on typical values.

5.

Review the Generation Increment setting. This value is used in the design process for the
length increment between section designs, 1' or 2' are common increments.

{KJ Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO

v [E=3EoR ==
Project || Sample Wall #1 Keywall PR@

Design Criteria | Wall Unit | Reinforcement | oil Conitions | Extreme Events | stations | Panels | Loading Conditions | Design | Internal Compound Stability

Suppliers
[Tencae Mirafi - Miragrid XT v]

Selected Wall Unit: Compac III (Keystone Pinned Systems)

Used in this Wall tion
)] - Miragri id 3XT
J ersion Date 2/9/18

ata Systems _ Stratagrid
TenCate Mirafi - Miraarid XT
Synteen - SF
Huesker - Fortrac

Tensar - UXMSE

2XT - Miragrid 2XT 2918

3XT - Miragrid 3XT 2918

SXT - Miragrid SXT 2/18 Soil Category Generation Increment
7T - Miragrid 7XT 2118 [onas I
8XT - Miragrid 8XT 2918
10XT - Miragrid 10XT 2018
/4"~ gravels or aggregate
1.5°- gravels or aggregate KRG REd HES
350000 145 115 1999.00 Ib/it
RFid cds <]
1.05 080 080

Connection Properties
Min. Connection Capacity
975.00 I/t

EXY

/’T

i

Normal Load (IP-1) Normal Load (IP-2)
130000 Ib/ft 225200 b/t

Connection Capacity

Conn. Capacity (IP-1) Max. Conn Capacity (IP-2)
215791 Ib/ft 229340 Ib/ft

Normal Load

Shear with Reinforcement
Initial Shear Shear Angle Maximum Shear

900.00 Ib/ft 3400 * 276200 Ib/it |Reset to Defauits

[National Concrete Masonry Association 3rd Edition

Version: 1.38.50.919

Keystone Retaining Wall Systems LLC
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Step 6 - Set Soil Condition Parameters

The Soil Conditions tab is for inputting the appropriate soil design properties for use in the analysis.
The User should have knowledge of project soil conditions and proposed backfill materials. The Soil

Conditions tab also allows for the optional definition of basic wall drainage elements and calculates neat
quantities that is not part of this simplified example.

The User will enter the appropriate effective stress parameters for the zones defined in the input table
and can add descriptions as needed.

1. Enter the friction angle (¢ angle) for the reinforced, retained, and foundation soil zones, 30°
used in this example.

2. Enter the in-place unit weight (y) for the reinforced, retained, and foundation soil zones, 120
pcf used in this example.

3.  Leveling pad material properties are only used for gravity wall design and can be ignored in
this example.

4. Soil description will not be added in this example.

Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO

\EHE!@‘
File Walls Settings Help
e [ KeyWall PRE@

Design Criteria | Wall Unit | Reinforcement | Soil Conditions | Extreme Events [ Stations | Panels | Loading Conditions | Design | Internal Compound Stabilty

Friction Angle  Cohesion Unit Weight Frict. Factor Soil

Reinforced [ @]°  nf [Coofere 02
Retained E]@ 0.00| bjft2 @ nfa @
Foundation Ev 0.00 bjft2 lb/ﬂ’ nfa
Leveling Pad E]@n/a nfa

Reset to Default Sois | [ Apply Sois to All wals

Retained Fill Cut Angle 0.00 =
Include Drainage
Drainage Be 0 115.00 bjft> 0.70 * ot acaurate to entered inputs,
representative only.
Thickness
Face Drain 0.00|inch  Impervious Cap Depth 0.00|inch @ At Grade AtBase
0.00|inch
00| inch % of Height
Version: 1.38.50919 [National Concrete Masonry Association 3rd Edition

Keystone Retaining Wall Systems LLC

Mar 9, 2018
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Step 7 - Extreme Events

The Extreme Events tab is for inputting seismic parameters and will be ignored in this simple example.

Step 8 - Stations & Elevations

The Stations tab is for inputting top and bottom wall stations and elevations from which KeyWallPRO will

window below also.

calculate the wall envelope required to meet the design requirements. An outline preview is shown in the

1.

2.

and grading. In this example, the bottom is level at El 100 over the 100' length.

Enter the top of wall station and finished grade elevations taken from the wall alignment and
grading. In this example, the top slopes up from El 100 to EI 110 over 100 feet.

Enter the bottom of wall station and finished grade elevations taken from the wall alignment

Note: The beginning and end stations for the top and bottom of wall must match before leaving this
screen or the program will not proceed.

Station Top
( 1) 0.00 100.00f

{KJ Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO

[E=3EEE X
File Walls Settings Help
prject || Sample wal =1 KeyWall PR@
Design Criteria | Wall Unit | Reinforcement [ Soi Conditions | Extreme Events | Stations |panels | Loading Conditions | Design | Internal Compound Stability
Elevation View
[ Crest Geometry Toe Geometry Enteras ©) Elevation Slope

Station Entry | Resolved Stations |

(=]

Toe Offset Toe Elevation

Version: 1.38.50.919

Bench (0.00

ft

Crest Offset  Crest Elevation

Embed.
calc

[National Concrete Masonry Association 3rd Edition

Keystone Retaining Wall Systems LLC
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Step 9 - Panelization

The Panels tab is where KeyWallPRO creates the block layout necessary to meet the geometrical
requirements of the design. The trial wall profile will automatically be generated upon selecting this tab.

The User has control in this screen to re-layout the wall by varying parameters or manually adjusting
individual panels.

This first wall elevation below is generated based on the design criteria settings and the default selection
for caps not being included in the profile generation. The second wall elevation has been generated by:

1. Changing the Min. Embedment to 1.0".
2. Checking Include Cap in Height for a more efficient layout.

3. Pressing Generate which creates a new profile based on a different top of wall datum and
embedment criteria that will be used for the rest of sample design.

[KJ Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO =3 o (===
File Walls Settings Help
[ | — KeyWall PR@
[0 e[ il it | Reiforcemnt ] 5o Condions T e ]
. 1 Embedment 1000 %  Min, nt. 050 ft ormde Abgomerne
B % ®Top Datum (S Mark
: Bl FacelCopArta] 3575 [HEIPaneiiock Areal ovsso 2l N ccciom T 1100t Ml M,
;‘ Column Settings
5
"
s 11033
o A
10 - [ T
11 =
o (D sewt | e
13 1
. — -
15 e il
— - i
1 i
AT
Pl
0867 S S Rt it
0.00 [KJ Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO =N EoR <=
Panel 1 File Walls Settings Help
Top: 101007 Width: 6001t Left 0.00ft  Area: 10.0
Base: 09.33ft Height 1671t Right 600ft GridArea'd Pproject | | Sample Wall #1 Keﬁ }Wa ll PR&
EEEE0O | Design Criteria | Wal Unit | Reinforcement | Soil Conditions | Extreme Events | Stations | Panels |Loading Conditions | Design | Internal Compound Stabilty
Version: 1390928 [National Concrete Masonry Aszociation 3rd Edition Sections  Wall Settings
e Alignment
i — . Em S ot
; Panel Cap Area 3375 ft°  Panel Block Area 61700 ft* Bottom [[] 11000 ft 7] show G«
‘; Column Settings
5
7
s . 110.00 —
9 —
10 = LT
: Zi
12 o
-
14 =
i 3 I (3)
e
o
T
—
—
—
-
»v/’_
99,00 & <
0.00 101.25
Panel 1
Top: 100.67 ft Width: 6.00ft Left: 0.00 ft Area: 10.00 ft* Crest Slope 0.00° Embed: 1.00 ft
Base: 99.00 ft Height: 1.67 ft Right: 6.00ft Grid Area: 0.00 yd* Toe Slope: 0.00° Embed: 150.00 %
FUEHD
Version: 138.50.919 [National Concrete Masonry Association 3rd Edition Keystone Retaining Wall Systems LLC
Mar 9, 2018
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Step 10 - Loading Conditions

The Loading Conditons tab is for adding back slopes and surcharges to each wall section.

KeyWallPRO permits the offsetting of slopes and surcharges which provides considerable flexibility for
the User to model specific site conditons at every location along a wall.

For this example, a typical 50 psf live load will be applied to a level backslope for all wall sections. The
procedure is as follows:

1. Select any wall section in section or elevation windows.

2. Select Live Load, enter a value of 50 psf, and Tab to next cell. Wall section should show load
arrows behind facing.

3. Press the Apply To All button which will copy the selected section's loading conditions to all
other wall sections.

4, Elevation view now shows load arrows on top of all sections.

Note: Each section can have its own loading condition and be input individually. Controls are

provided to speed up this process for copying to adjacent sections.

{K] Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO

[E=8 I8 ==
File Walls Settings Help
Project | | Sample Wall #1 Keywall PR@
| Design riteria | wall Unit | Reinforcement | Soi Conditions | Extreme Events [ stations | panels | Loading Conitions | Design | Internal Compound Stabilty
m] e Elevation View
] Slope 000 *
2
3 CrestOffset 0,00 ft
4 110.00 far e SRR LI
5 Surcharges T v
g Liveload 5000 Ib/tt: P B I 113
o | e TY(2) i
fu Deadload 000 IbFE 99.00 [
11 Dead Offset 0,00 ft 0.00 101.25
12

13
s | ] BEO
15
4 Extend Left
i Extend Right
Copy From Left
Copy From Right y
&7 Clear Selected -

Section View

i&il&i{l»i&i&#i&i&&i&@

Left: 0.00 ft

Right: 6.00 ft

Base: 99.00 ft

Top: 100.67 ft
Height: 1.67 ft

- Exposed: 0.67 ft
- Embedded: 1.00 ft
- Design: 1.60 ft

(4 [

[National Concrete Masonry Association 3rd Edition

Version: 1.38.50.919

Keystone Retaining Wall Systems LLC

Mar 9, 2018
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Step 11 - Design Generation

The Design tab is where the reinforcement design generation and analysis takes place. KeyWallPRO
will perform a trial generation based on the Design Criteria spacing criteria and the reinforcement type
and increment specified in the Reinforcement tab.

For this example, a trial generation will be done from the information previously input.

1. Press the Generate All button and KeyWallPRO will attempt to generate a design for all wall
sections based on the criteria previously entered or use default values.

2. Review the Elevation View looking for any "Red" sections that would indicate an analysis
failure of any of the design criteria. All sections are green in this simple wall generation which
means the design meets the minimum design criteria.

3.  Select the tallest section in the elevation view. The design section is shown in the Section
View window and the reinforcement length is determined based the 1.0' length increment.

4.  The Quick Results displays a results summary for the section selected. Any design criteria
failures can be located in this listing and the design modified to satisfy the requirements.

Note: The Design tab has many features for controlling the design generation and analysis that are

beyond the scope of this simple wall design. Please review the Help file for further explanation
of buttons, check boxes, and input values.

[KJ Project 2018: Sample Wall Design [Rev. 1] - KeyWallPRO ol e ==
File Walls Settings Help
Project || Sample Wall #1 Ke y V\/all PR@
Design Criteria | Wall Unit | Reinforcement | Soi Conditions | Extreme Events | stations | Panels | Loading Conditions | Design | internal Compound Stabilty
! Elevation View
Sect
SN Course: Elevation: 99.00  ft
1
2 [7] use No Fines
3
Reinforcement il
4 [ ! ) (& ] 110.00 13 R
5 Miragrid 3XT v =8 Edit AN
= == R N
6 RN\
N P " =
8
9 [] Force Uniform Grid Length NN
o 00,00 —— BN
1 [ o Add ] [ X Remove ] -
12 0.00 101.25
13 [ 4! Extend Left ] [ 19 Extend Right ]
14 =Rl
s | [EMovaUp HMaveann ] FEEHO
[ % Minimize Lengths | [ &7 iear Panel ] Zi00 N
Section 15 Quick Results @ static Seismic
-
More Grids | ST 1 AEEEEEEEEEEEEEEEEEEEE RN N (pmreyem Layer Course Value 4
Grid Group Increment External
[Clapply 0.50 P {Miragrid 3XT} 8.00 ft o Bearing Cap.. 8.52
N\ o CrestToppling 14 295
[ cenerate ( 1 )| &/ Generatean | " , o Overturning 592 |F
~{Miragrid 3XT} 7.00 ft  Base Sliding 3.07
s Auto Grid Group | [ 7 Add Group | @ Internal
— —/— — -{Miragrid 3XT} 7.0 Left 93.00 f o Pullout 5 14 175
[ Mlew,Croups ] [ M), ClearCrouns ] Right: 101.25 o Internal Slidi... 1 2 361
Base: 99.00 ft o Tensile Over... 1 2 292
Analysis — — — ~{Miragrid 2XT} 7.00 t Top: 110.00 f =
[ 3 Analyze Panel ] [ 3 Analyze All ] F;?:::e:!nfoﬂﬂﬂﬂ ¢ Connection... 1 2 296
— — — — -{Miragrid 3XT} 7.00 ft - Embedded: 1.00 ft
[9) Full output - Design: 11.00 ft o Minimum Em... 10.0000% ~
Alpha: 52.95¢ ~Total Quantiies
Trial Wedge i
- it FT) Panel Wall Area: 617.00 ft
Apply 1 d 1 C Reinforcement Area:  198.00 yd*
H@E Infill Volume: 11478 yd*
Version: 1.38.50919 [National Concrete Masonry Association 3rd Edition Keystone Retaining Wall Systems LLC
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Step 12 - Printout Results

When the wall design is complete, a printout of the quantities and selected design section summaries is

typically required by the User.

1.
2.

w

Select PDF Report from File menu.
Select Section(s) from the Wall/Sections window.
(Control-Click to select multiple sections)

Select Summary Report check boxes desired.
Press Preview/Print button.

Report Options

Wall/Sections

==

7. Stations 39.75 - 46.50
8. Stations 46.50 - 53.25
9. Stations 53.25 - 60.00
10. Stations 60.00 - 66.00
11. Stations 66.00 - 72.75
12. Stations 72.75 - 79.50
13, Stations 79.50 - 86.25
14, Stations 86.25 - 93.00
15. Stations 93.00 - 101.25

(2)

o Select All

n

Nt
Summary Reports Section Geometry
Walls  Settings  Help [¥] Project Materials Summary @ [ station Information
New Project » [¥] section Analysis Summary [~] station Drawing
Open Project ... Ctrl+O ["] Panelization Details
SaveAs ... Ctrl+S Project Information [7]Panelization Drawing
Load Project From ... Ctrl+L [ Detais [FMarkers
»
New Project From Template [] Comments Reinforcement Details
Save Project as Template Ctrl+T
g B |Revision Comments Analysis Resuits
PDF Report ... Ctrl+P [ Tallest Section Drawing [7]Factors of Safety Summary
Bxportto Autotad... [Clsecton Overview | Cross-section Detail
Export to GSlope i
P P [] Quantities [7] Cross-section Drawing
Export to ReSSA ...
¢ Project Design Inputs [“]Factors of Safety
Import Block Definition File |standards / Factors of Safety | Detailed Static Calculations
Bt [F wal Uit [ Detailed Seismic Calculations
[ soil Conditions =
|Reinforcement 1CS Seismic
Select All Options [¥] Include Preliminary Note
Project: 2018 - Sample Wall Design [Rev. 1] USA| Summary
Save PDF Report to...
Client ‘Sample Wall Design W:\KWP TEST FILES Wall D df
; mple esign.
Name Sample Wall Design Number 2018 W \Samp - .
sit usa Desi E save [ Preview /Print i Close
e esigner  cm ’ Iz / Ind
Revision 1 Created 3/15118 Modified 3/9/18
Standard  National Concrete Masonry Association 3rd Edition
Note Project: 2018 - Sample Wall Design [Rev. 1] USA Wall: Sample Wall #1
Section #15 at Station 93.00
Report Date March 09, 2018
Note Designer om
Design Standard National Concrete Masonry Association 3rd Edition
Design
Note Unit of Measure U.S.imperial
I the percentage Selected Facing Unit Product Line: Keystone Pinned Systems
pac Il
Seismic As NA
Nota ¢
Othrcapping systcms may mayreul nfernt auanfios
Quantities Soll Parameters  Phi Angle  Cohesion Unit Weight
. Soil Zone [degrees] [1b/ft] [IbAt"] __ Description
/all/Cap ToW Facing Cap Total Wall Reinforced 3 Wa 120,00
Wall Facing Length [ft] Pins _ Steps Area[f] Area[ft?] Area [ft1 Rotainod pos 000 12000
Sample Wall #... Compac lll 101 1145 14 640 44 684 Foundation 30 0.00 120.00
10 1145 14 640 “ 684 Leveling Pad 40 nla nia
Leveling Reinforced Drainage Core Section Details
d Fil Fill Fil Section Height 1167 Back Slope 000 LLSurcharge 0 DLSurcharge 0
Wall Lyd? [yl [yd] [yd’] DesignHeight ~ 11.33  Crest Offset 000  LLOffset 000 DL Offset 0.00
Sample Wal #1 4 116 [ 0 Embedment 133 WallBatter 800 Toe Slope 000 Toe Offset 0.00
Totals: 4 116 0 10
Minimum Factors of Safety
Reinforce nts Reinforced
3XT Geogrid External Value _Internal Value _Facing Value
Wall [yd?] FSsl Base Sliding 150 FSsl Intemnal Sliding 150 FScs Connection Strength 1.50
Sample Wall #1 227 0 FsSbe Bearing Capacity 200 FSpo il 150 FSsc Facing Shear 1.50
Totals: 227 o FSct Crest Toppling 150 FSto Tensile Overstress 1.50
FSot Overtuming
Reinforcements
grid 3XT Supplie - Miragrid XT, Fill Type: Sands
Tult 3,500.00 RFer 145 1.15 LTDS 1,999.00
1.05 Cds 0.80 a
Connection/Shear Properties
aest 97500 P4 130000 ces2 215791 P2 225200 acsmax 229340
au 900.00 A 34.00 Vu(max) 2,762.00
Analysis Results
* Analysis does not include Vertical Forces
*+ Embedment included in Bearing Capacity
External Static. FS
Bearing Capacily 508 Bearing Pressure 736001 BT
Overturning 624  Max Eccentricity 000 ft
Base Sliding 3.20
Crest Toppling 10.08
Internal Sliding 350
Internal Static Tensile Tensile Pullout Pullout Conn. Conn.
Layer Elevation  Rein Length Load  Resist. FS_ Resist. Resist. Fs
s 0867 3XT 900 78 1999 2564 274 352 1121 1437
5 10667 3T 800 191 1909 1047 0 403 1339 701
vore: QuanTmEs, Ao L 4 10467 3T 7.00 306 1999 654 1368 448 1557 510
3 10267 T 7.00 420 1999 476 2880 68 1776 423
" 2 100.67 3T 7.00 438 1,999 457 4,936 11.28 1,994 4.56
[C] Powered by KeyWailPRO Paga Printed 319 1 9933 XT 700 407 1999 491 6610 1623 2140 525
Version: 1.39.0
o uaNTTE
I77] Powered by KeyWallPRO Page 3 Printed 3918
AN Version: 1.39.0.928
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